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Abstract: With the growing technological advancements, a really prevailed downside within the aeronautical institutes
is the Bird Strike that has to be handled in a sophisticated manner. A Bird Strike is strictly outlined as a collision between
a bird associated with an aircraft that is on the wing or on a Take-Off or Landing roll and also the term is usually swollen
to hide alternative life Strikes — with haywire or ground animals. Bird Strikes typically occur throughout the Take-Off
or Landing sections thanks to the lower altitudes of the aircrafts throughout that phase. Indian airports have recorded a
gradual increase in range of bird hits and craft run-ins with stray animals over a minimum of the past 5 years, in step
with official information, illustrating the potential safety risks and losses the aviation business confronts from such
accidents because the fleet of planes operated by domestic airlines expands apace. in step with board of directors General
of Civil Aviation (DGCA) an information was provided in response to a Right to data (RTI) application filed by
geographic area Times that contained the amount of Bird Strikes. In 2014, the amount of bird hits and animal strikes was
719, in 2015it absolutely was 764, in 2016 with a count of 839, in 2017 a spike of 1125 was noticed and in 2018, the
count was 1244. The current techniques showing smart results against Bird Strikes aren't effective enough to beat this
downside. Therefore, this paper produces a plan with usage of sound to forestall Bird Strike that disturbs the birds and
causes them to maneuver away. To overcome this downside, we tend to square measure reaching to use “Ultrasonic
radiation” which will be radiated throughout the flight takeoff and landing that disturbs the birds (without harming them)
and additionally not moving the pilots throughout their flight.

Keywords: Foreign Object, Sensors, Ultra Sonic, Aircraft

l. INTRODUCTION

Bird strikes happen most often during Takeoff or Landing, or during low altitude flight. The majority of bird collisions
occur near or at airports (90%, according to the International Civil Aviation Organization (ICAO)) during Take-Off,
Landing and associated phases. According to the FAA (Federal Aviation Administration) and wildlife hazard
management manual for 2005, less than 8% of strikes occur above 900 meter (3,000 feet) and 61% occur at less than 30
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meters (98 feet). Noticing the facts of this survey the Bird Strike prevention should be concentrated at lower altitude
regions. Before discussing about the prevention techniques, one must know the importance of building a device for
prevention. The aircrafts undergo a huge impact due to the Bird Strike. The collision along with damaging the parts of
the aircraft also disturbs the pilot which hence causes hindrance in having a safe flight. The upcoming section describes
the various hazards caused to the aircrafts when it undergoes a Bird Strike.

1.1 Effects of Birds Strike

The nature of aircraft damage from Bird Strikes, is significant enough to create a high risk to continued safe flight, and
along with this the impact of damage also depends on size of aircraft. Small, propeller-driven aircraft are most likely to
experience the hazardous effects of strikes as structural damage, or damage to control surfaces or the empennage. Larger
jet-engine aircraft are most likely to experience the hazardous effects of strikes as the consequences of engine ingestion.
Partial or complete loss of control may be the secondary result of either small aircraft structural impact or large aircraft
jet engine ingestion. Loss of flight instrument function can be caused by impact effects on the Pitot Static System (A
system pressure-sensitive instruments which is used to determine an aircraft’s airspeed, Mach number and altitude).
Complete Engine failure or serious power loss, even on only one engine, may be critical during the take-off phase for
aircraft.

An example related to the type of damages that occurs during a Bird Strike is depicted in the figure 1.1 below

/

Fig 1: An example of Bird Strike and damage to the plane

According to a research the point of impact is usually any forward-facing edge of the vehicle such as a wing leading
edge, nose cone, jet engine cowling or engine inlet. Taking an example of the impact caused due to the Jet Engine
ingestion is explained in the below context. Jet engine ingestion is extremely serious due to the rotation speed of the
engine fan and engine design. As the bird strikes a fan blade, that blade can be displaced into another blade and so forth,
causing a cascading failure. Jet engines are particularly vulnerable during the takeoff phase when the engine is turning at
a very high speed and the plane is at a low altitude where birds are more commonly found. The figure 1.2 & 1.3 below
depicts the effects caused by Bird Strike on the Jet Engine part of the aircraft. A bird of size not comparable to the aircraft
can cause enormous damage is an astonishing matter. The science behind this explained in the next context.

L — =\ . \ .Jr
Fig 2: Normal Jet Engine and Jet Engine after Bird Strike

The force of the impact on an aircraft depends on the weight of the animal and the speed difference and direction at the
point of impact. The energy of the impact increases with the square of the speed difference. High-speed impacts, as with
jet aircraft, can cause considerable damage and even catastrophic failure to the vehicle. The energy of a 5 kg (11 pounds)
bird moving at a relative velocity of 275 kilometer/hour (171 miles per hour) approximately equals the energy of a 100
kilograms (220 pounds) weight dropped from a height of 15 meters (49 feet). At normal speeds, during a perfectly
inelastic collision an object struck by a projectile will deform, and this deformation will absorb most or all of the energy
due to the force of the collision and when it is viewed from a conservation of energy perspective, the kinetic energy of
the projectile is changed into heat and sound energy, as a result of the deformations and vibrations induced in the struck
object. However, these deformations and vibrations cannot occur instantaneously because a high velocity collision does
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not provide sufficient time for these deformations and vibrations to occur. Thus, the struck material behaves as if it were
more brittle than it would otherwise be, and the majority of the applied force goes into fracturing the material. Taking
into heed to the above matter, different approaches were taken into consideration for improving the harmful effects caused
to both birds and the aircraft.

1.2 Approaches towards Prevention of Bird Strike

Knowing the various impacts caused due to Bird Strike, aerodromes have applied some techniques to detect the birds and
their activities which can help the aerodrome authorities to take certain measures before the Take- Off or Landing of any
aircraft.

Detection of Birds applied by Aircraft Institutes during Flight:

e Visual: Birds seen in close proximity to the airplane or colliding with the airplane will be noticed along with bird
remains on windshield, cracked windshield. A next step will be taken to avoid these occurrences.

e Tactile: When there is vibration of airframe or engine, thrust loss, asymmetric thrust, increased drag, abnormal
airplane handling characteristics, the pilot will sense these by using tactile sensing devices. This alerts the pilot that
the flight is in an uncoordinated condition and must be corrected.

e Auditory: Noise of strike or noise attributed to resulting damage such as engine surging, compressor stalls,
aerodynamic noise from damaged radome (aerodynamically shaped dome which protects the radar situated within
the aircraft), loss of pressurization from pressure vessel penetration indicates the pilot, some dangerous states of the
flight.

e Olfactory: Smoke, odor, or cooked bird smell gives a sense of alert.

e Engine indications: Reduction or fluctuation in primary power parameter (e.g., engine pressure ratio, fan speed, or
equivalent), abnormal fuel flow, abnormal engine vibration monitoring (e.g., error vector magnitude or equivalent),
engine failure, engine exceedances.

e Flight instruments: Loss of data or erroneous indications arising from damage to air data sensors or angle-of-attack
Sensors.

Other airplane systems or structure affected directly by a strike: Damaged communications or navigation antennas,

damage to exposed electrical wiring or hydraulic lines, damaged radome or weather radar, broken landing lights, or

cascading and multiple effects from sensor damage or engine damage. Along with several detection measures there is
another method to prevent the Bird Strike during the Take-Off, i.e. to decide whether to continue the flight or report an
emergency landing after a Bird Strike has occurred.

Bird Strike during Take-Off: If a bird strike occurs during Take-Off, the decision to continue or reject the Take-Off is
made using the criteria found in the Rejected Take-Off maneuver of the QRH (Quick Reference Handbook contains all
the procedures applicable for abnormal and emergency conditions in an easy-to-use format). If a bird strike occurs above
80 knots and prior to V1, and there is no immediate evidence of engine failure (e.g., failure, fire, power loss, or
surge/stall), the preferred option is to continue with the takeoff followed by an immediate return. On 8th August, 2020
an AirAsia flight Take-Off was aborted due to a Bird Strike hence saving aircraft damage and the passengers within the
aircraft.

Table 1. Recent Wildlife Strike statistics:

AIRPORTS 2019 2018 2016 [2015

Ahmedabad 10.39 [14.89 [11.61 [13.26

Goa 7.36 7.44 5.84 [3.29
Delhi 5.36 4.75 5.17 [3.54
Mumbai 2.38 3.16 245 .44
Bangalore 1.58 3.05 1.80 [2.67

Hyderabad 2.21 4.21 4.26 [3.38
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Chennai 3.16 4.48 3.06 [2.98

Kolkata 2.88 5.23 3.80 [3.47

Note: Data as per 10,000 flights

A novel approach taking into all other approaches into matter is to use ‘special sound’ which disturbs the birds but does
not harm them. This special sound is Ultrasound which varies in frequency from 15 Kilo hertz to 30 Kilo hertz. Ultrasound
is a sound wave with frequencies higher than upper audible limit of human hearing (i.e. 20 Hertz to 20 Kilo hertz).
Though it has physical characteristics similar to the audible hearing of humans, it is inaudible to humans. Ultrasound
belongs to the long wave region of the spectrum (i.e. short frequency). The advantage of long waves being, less
attenuation in free space compared to short waves or high frequency signals. This one characteristic of ultrasound ensures
effective transmission in free space with comparatively less attenuation. Ultrasound has till now being used to detect
cracks in metals or other faults and another important application is in the medical field called as sonography. A new
field for application of ultrasound has been initiated in scaring the birds and preventing Bird Strike. The speed of
ultrasound in air is 1108 Kilo meter/hour which is much greater than the speed of aircraft during Take-Off or Landing
which is approximately 240- 285 kilometer/hour. Hence these signals radiate faster than the Take-Off of the aircraft. The
ultrasonic radiations produced will be radiated through piezo speakers. These radiating devices must be placed in the
respected aircrafts which will be turned ON during Take-Off and Landing. Range of ultrasonic device — 50 feet (15meter).
For real time applications we need to design a device which covers a distance of 10km.

1. LITERATURE SURVEY

The new approach initiated has been put into progress after a survey of varied techniques which provides a green signal
in using ultrasonic radiations for scaring away birds. Bird Strike, which doesn’t sound as a crucial global cause has
become a nerve striking problem for all the Aeronautical institutes. The importance of conducting survey of problem
within the aerodromes every five years by an expert is now a necessity which has employing an Ornithologist at every
aerodrome, need for normal national-level training for bird-controllers and urgency for fixing Bird- strike Prevention
Committees at national and airport levels depicted by S. M. Satheesan et al [1]. A data represented few techniques which
was surveyed by S. M. Satheesan et al [1] and it consisted of the following:

Field observations from tower of aerodrome and inspection within 25 km in radius of the aerodrome to locate areas of
bird activity and to seek out the explanations for attracting birds and the way these birds become a hazard to aircraft and
hence decision of aircraft timings will be altered or withheld. Gathering bird strike data and bird strike remnants on a
national level and from each aerodrome whenever survey was conducted. This step helps in knowing the aerodromes
which have greater concentration of bird habitats and therefore the rate of the aerodrome to be easily suffering from Bird
Strike. Evaluating efficacy of bird repelling cartridges, other devices and machines additionally as herbicides and
insecticides. Providing practical, cheap, long-lasting, ecologically and environmentally sound measures like
modifications to cut back water-logging, instituting effective system, mowing vegetation cover, erecting tall barbed
fences, repairing breached concrete boundary walls and shutting down of a bird-attracting waste-yard very near a runway
end, to tackle bird menace to aircraft in and around aerodromes and evaluating these recommendations from time to time.
Conducting a survey of Bird Strike is a crucial task because it is causing enormous damage to some parts of the aircraft
hence becoming a threat for a secure flight. An exploration shows few of the parts which are highly liable to Bird Strike
damage depicted in Fig 4. Zdobyslaw Goraj & Kamila Kustron et al (2018)[3] focuses on summarizing current research
trends in bird strike and hail impact simulations on vanguard (LE) and on expectations of all stakeholders in civil aviation
that safety must be increased.

According to Zdobyslaw Goraj & Kamila Kustron et al (2018)[3] there are four ways to scale back the effect of the bird-
strike:

the aircraft will be designed to be bird-strike resistant,

the aircraft can have lower speed during critical phases of flight
the birds are often quarantined of the way of the aircraft

the aircraft may be abstracted of the way of the birds.
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There are two different strategies from the regulatory side used for bird strike risk mitigation in aviation [3]. The primary
strategy relates to the look of the forward-facing aircraft components to fulfill resistance to impact so as for them to
become them resilient and fewer prone to the incidents concentrating on a way to strengthen aero structure designs to
attenuate damage and ensure safety. It includes the activities associated with passive safety.

Aviation authorities require that wing LEs must prove a specific level of bird strike resistance in certification tests before
the aircraft is permitted to travel into service. During this particular strategy the stronger the components are made the
more resistant they become. To extend the resistance a heavier component material are going to be necessary, which
causes a controversy in an exceedingly normal Take-Off because the aircraft becomes heavier. The second strategy is
targeted on reducing aircraft exposure to bird strikes, because the problem is especially associated with take-offs and
landings, the strategy concentrates on the actual conditions of airports and also the have to applicate the active safety
solutions. This is often the strategy we are visiting apply to scale back the Bird Strike. Another simple technique to
frighten away the birds was to reinforce aircraft visually through a bright color scheme might facilitate a bird’s ability to
detect and distinguish aircraft shape in time to perform avoidance behavior researched and applied by Isabel C. Metz,
Joost Ellerbroek, Thorsten Milhlhausen, Dirk Kugler, Jacco M. Hoekstra et al (2020)[4].

For turboprop aircraft, such a bearing is gained by applying colored patterns to the propeller to boost the aircraft’s contrast
against the sky. Research on increasing aircraft lighting found that pulsing light has the potential to reinforce avian visual
awareness. However, as seeing depends on the bird species, different pulsing frequencies and wavelengths may be
required. An experiment identified that certain wavelengths do trigger strong avoidance reactions of birds, while other
wavelengths didn't cause any behavioral response. This means that the selection of lights to be installed can support
successful collision avoidance. Radio Detection and Ranging (RADAR), an invention which gave solutions to varied
problems (Detection of aircraft, ships, spacecraft, weather outlook etc.) was also applied within the task of reducing Bird
Strike. ‘Bird Strike Avoidance Radar’ equipment, Jaiye Jehoshaphat Dukiya, Vimal Gahlot et al (2012) [5], that may
alert the tower which can successively alert the pilot of the presence of birds along his way be installed in major airports
within the country. Since modern aircraft aren't any longer noisy to dash most birds, bird repellents should be built into
aircraft and airports. The Bird/Wildlife Hazard Control (B/WHC) unit of all the nations’ international airports should be
trained and equipped with current equipment which will repel birds round the ports. RADAR is one among the methods
which is currently dominating all other techniques of reducing Bird Strike because it has proven to be effective to a good
extent. But the sole drawback is that the message sent via RADAR are often delayed hence the pilot may receive the
message at the incorrect time and thus resulting in a mismatched situation. Similar to Aviation institutes, even crop fields
and Transmission lines also face problems by birds. Hence Fuliang Le, Jiawei Luo, Gongping Wu et al (2009)[6] came
up with three different techniques to displace the birds including an induction compensating power to resolve the matter
of acquiring power.

The induction compensating power can transform magnetic energy around transmission lines to electricity for battery
charge, therefore the bird repeller can work uninterruptedly on the transmission lines. The facility consumption is not up
to the traditional repeller and hence the equipment can work uninterrupted with lighter battery by using ICP as
compensating power. Keeping aside the facility saving a part of their experiment and concentrating on three methods of
driving away the birds which includes; Sound shock, Ultrasonic shock and Electric shock. The Sound shock includes
producing sounds of howls, tigers or cruel animals when the bird is nearby. The downside of this method is that the birds
can get vulnerable to the sounds after long-term usage of this method. The Ultrasonic shock includes radiating ultrasonic
waves because of which the birds get a disturbed feeling which was explained by Dr. Whitford. The electrical shock
includes producing high voltage signals when the birds are nearby. This cause an enormous impact on the lives of birds
because it are often highly dangerous to their livelihood. A similar area of bird problem is that the crop fields which are
highly suffering from their activities. Another prototype involving Ultrasonic radiations, Yahot Siahaan, Bheta Agus
Wardijono and Yulisdin Mukhlis et al (2017)[7] has used a motion detection system which then proceeds to a repellent
that generates a selected frequency, that the bird are visiting be disturbed. This prototype consists of PIR sensors as a
detector to detect movement from birds and using LC oscillator type Colpitts with Piezo Ultrasonic sensor as repeller.
The results of the experiment are the PIR sensor working with a detection distance between 0 cm - 500 ¢cm, and so the
bird are visiting be disturbed at a frequency signal of about 60 kHz. The prototype shows a list of assorted birds getting
disturbed at varying frequencies.
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1. METHODLOGY

PROBLEM IDENTIFICATION
TOPIC SELECTION CASE STUDY
LITERATURE REVIEW

BIRD FREQUENCY INVESTIGATION

DIFFERENT AIRCRAFT SIGNALS

COMPARISON & ESTIMATION OF SIGNAL

IMPLEMENTING FOR THE ULTRASONIC SENSOR

DESIRED OUTPUT

CONCLUSION

Fig 4: Flow chart of process

After seeking the data and also the properties of Ultrasound and its impact on birds we'd prefer to maneuver forward to
develop the device generating these frequencies and diverging them out. Ultrasonic waves are generated by transducer
that has a crystal that converts power (electric current) to energy (sound waves). Ultrasonic repellents area unit a necessity
in aeronautical institutes throughout the Take-Off and Landing periods of aircrafts. Due to the Bird Strikes caused it
creates an imbalance within the eco system destroying the bird life and additionally affects the aircraft infrastructure.
Looking forward to the dimensions of the aircraft, one speaker for emitting ultrasonic waves doesn't satisfy the
requirements. Hence, phased array within the context of an array of ultrasonic speakers is steered to point in several
directions without moving the speakers. A phased array transducer encompasses a small footprint, but the ultrasound
beam is steered electronically to provide a sufficiently wide far field of view. The ultrasound beam diverges from virtually
the identical point within the transducer. Hence making the ultrasonic waves radiate in multiple directions is that the next
motive after generating them. As we've got discussed within the above context within the section ‘Impacts of Bird Strike’
regarding the damages caused to the aircraft, the which are parts of the aircraft which are highly liable to Bird Strike and
leading to an enormous damage.

To avoid these damages the ideology we have used, helps play a regular role. As mentioned by a writing, consistency of
the device and exertions is a vital and major needed talent to realize the task. A novel approach was hence developed
using the ultrasonic radiations which will be radiated using piezo speakers during the Take-Off and Landing. There are
few arguments related to birds hearing ultrasound. In 1960 it was proposed that birds could not hear ultrasound. Bird-X
and Dr. Philip Whitford have proved that birds are sensitive to ultrasound. Dr. Whitford observes a goose’s response to
ultrasound in a lab setting, before he stopped the experiment, due to the distress clearly experienced by the goose. He
tried experimenting with geese and a very high-tech ultrasound generating device from a university. He brought a goose
into the sound lab in a large dog crate and tested it with a burst of 22,000 (Hz) sound. The bird toppled over instantly and
became a rigid mass of flesh. Only the eyelids flickered open and closed. Within a minute of the time the sound stopped,
the goose recovered and stood, seemingly unharmed. He repeated the test several more times with the same results. He
only speculated based on outward appearances that at that distance and intensity, the ultrasound may have affected
molecular level channels of nerves and muscle cells. Whatever it was, it was a striking response to the sound. This article
gives a clear explanation of bird behavior when they come across ultrasonic waves. The device consists of the PIC 18
microcontroller which is the important unit that generates the respective frequencies followed by piezo ultrasonic speaker
to radiate them.
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V. PROPOSED MODEL

4.1 Ultra Sonic Sensors

A piezo electric material could be a non-conductive material which produces electricity when the fabric undergoes
mechanical stress. The materials may also deform when field of force is applied thereto. The word ‘piezo’ refers to
applying pressure or squeezing within. The HC-SR04 Ultrasonic distance sensor consists of two ultrasonic transducers.
The one acts as a transmitter which converts electrical signal into 40 KHz ultrasonic sound pulses as shown. The receiver
listens for the transmitted pulses. If it receives them it produces an output pulse whose width will be accustomed
determine the gap the heartbeat travelled. The ultrasonic transducer is used to radiate the generated frequency. The VCC
pin is connected to VCC (+5 Volts) and GND is connected to ground. The RC2 pin of the microcontroller is usually used
as an output pin hence it is connected to the Trigger pin of the Piezo speaker as it is an input pin. The echo pin is connected
to the RB4 pin of the microcontroller.

Foce I —&y
oo 2 R s v

Fig 5: Piezo Electric Speaker

4.2 Circuit Diagram

Fig 6 Circuit diagram for Experimental Analysis COMPONENTS:
The materials that we need to make this project:

Arduino UNO R3 CH340 (you can use any Arduino Boards)
Ultrasonic Sensor HC-SR04

Male to Male Jumper Wires

Breadboard
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4.3 Experimental Setup:

The connection of Arduino and Ultrasonic Sensor HC-SR04

Inorder to generate the ultrasound we need to set the Trigger Pinona High State for 10 ps. That will send out
an 8 cycle sonic burst which will travel at the speed sound and it will be received in the Echo Pin. The Echo Pin will
output the time in microseconds the sound wave 14ravelled.

Trig Pin ﬂ

10us Trigger Pulse

Pulses
from module

Eight 40KHz Sound wave generated from HC-SR04

ECHO Pin

Time taken by pulse to leave and return back

Fig 7. Ultrasonic HC-SR04 timing diagram

For example, if the object is 20 cm away from the sensor, and the speed of the sound is 340 m/s or 0.034 cm/us the sound
wave will need to travel about 588 microseconds. But what you will get from the Echo pin will be double that number
because the sound wave needs to travel forward and bounce backward. So in order to get the distance in cm we need to
multiply the received travel time value from the echo pin by 0.034 and divide it by 2.

L(C((c
)))

<€ >

20CM

Fig 8. Distance calculating

For the programming code, first we need to define the Trigger Pin and Echo Pin that connected to Arduino board. In this
project EchoPin is attached to D2 and TrigPin to D3. Then define variables for the distance (int) and duration (long).

In the loop first you have to make sure that the trigPin is clear so we have to set that pin on a LOW State for just 2 ps.
Now for generating the ultrasound wave we have to setthe trigPin on HIGH State for 10 ps. Using the pulseln()function
you have to read the travel time and put that value into the variable “duration”. This function has 2 parameters,the first
one is the name of the echo pin and for the second one you can write either HIGHor LOW. In this case, HIGH means
that the pulseln() function will wait for the pin to go HIGH caused by the bounced sound wave and it will start timing,
then it will wait for the pin to go LOW when the sound wave will end which will stop the timing. At the end the function
will return the length of the pulse in microseconds. For getting the distance we will multiply the duration by 0.034 and
divide it by 2 as we explained this equation previously. At the end we will print the value of the distance on the Serial
Monitor.

Steps :

e  First step is to do the wiring as per the proposed circuit
e Open Arduino IDE Software and write down your code, or download the code below and open it.

e Choose your  own Arduino board  (in this case Arduino Uno), by selecting Tools >
Board > Arduino/Geniuno Uno.
e Choose your COM Port (usually it appears only  one existing port), Tools > Port >

COM.. (If there are more than one ports, try it one by one).
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e Upload your code by pressing Ctrl + U or Sketch > Upload.

e To display the measurement data you can use Serial Monitor by pressing Ctrl + Shift + M (make sure that the
baudrate speed is 9600).

4.4 Design

Arduino UNO R3 "

Micro Servo

Breadboard

Fig 9 Conceptual Design

Fig 10 “Ultrasonic sensors setup

4.5 Experimental Testing

Code to Execute The Sensors

import processing.serial.*; import java.awt.event.KeyEvent; import java.io.|OException; Serial myPort;

/I defubes variables String angle=""; String distance=""; String data=""; String noObject; float pixsDistance; int iAngle, iDistance; int index1=0;
int index2=0; PFont orcFont; void setup() {

size (1920, 1080);

smooth();

myPort = new Serial(this,"COM5", 9600); myPort.bufferUntil(.");

}

void draw() { fill(98,245,31);

noStroke(); fill(0,4);

rect(0, 0, width, 1010); fill(98,245,31);

drawRadar(); drawLine(); drawObject(); drawText();

void serialEvent (Serial myPort) { data = myPort.readStringUntil(.");
data = data.substring(0,data.length()-1); index1 = data.indexOf(",");
angle= data.substring(0, index1);

distance= data.substring(index1+1, data.length()); iAngle = int(angle);
iDistance = int(distance);

}
void drawRadar() { pushMatrix(); translate(960,1000); strokeWeight(2); stroke(98,245,31);
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/I draws the arc lines arc(0,0,1800,1800,PI1, TWO_PI); arc(0,0,1400,1400,P1,TWO_PI); arc(0,0,1000,1000,PI, TWO_PI); arc(0,0,600,600,PI, TWO_PI);
/I draws the angle lines line(-960,0,960,0);

line(0,0,-960*cos(radians(30)),-960*sin(radians(30)));

line(0,0,-960*cos(radians(60)),-960*sin(radians(60)));

line(0,0,-960*cos(radians(90)),-960*sin(radians(90)));

line(0,0,-960*cos(radians(120)),-960*sin(radians(120)));

line(0,0,-960*cos(radians(150)),-960*sin(radians(150)));

line(-960*cos(radians(30)),0,960,0);

popMatrix();

}

void drawObject() { pushMatrix(); translate(960,1000); strokeWeight(9); stroke(255,10,10); pixsDistance = iDistance*22.5; if(iDistance<40){
line(pixsDistance*cos(radians(iAngle)),-pixsDistance*sin(radians(iAngle)),950*cos(radians(iAngle)),- 950*sin(radians(iAngle)));

popMatrix();
}

void drawLine() { pushMatrix(); strokeWeight(9); stroke(30,250,60); translate(960,1000);
line(0,0,950*cos(radians(iAngle)),-950*sin(radians(iAngle))); popMatrix();

}
void drawText() { pushMatrix(); if(iDistance>40) { noObject = "Out of Range";

else {
noObject = "In Range";

}

fill(0,0,0); noStroke();

rect(0, 1010, width, 1080); fill(98,245,31);

textSize(25); text("10cm™,1180,990);

text("20cm",1380,990);

text("30cm",1580,990);

text("40cm™,1780,990);

textSize(40);

text("Object: " + noObject, 240, 1050); text("Angle: " + iAngle +" °", 1050, 1050); text("Distance: ", 1380, 1050); if(iDistance<40) {
text(" " + iDistance +" cm", 1400, 1050);

}

textSize(25); fill(98,245,60);
translate(961+960*cos(radians(30)),982-960*sin(radians(30))); rotate(-radians(-60));
text("30°",0,0);

resetMatrix();

translate(954+960*cos(radians(60)),984-960*sin(radians(60)));

rotate(-radians(-30));

text(""60°",0,0);

resetMatrix();

translate(945+960*cos(radians(90)),990-960*sin(radians(90))); rotate(radians(0));
text(""90°",0,0);

resetMatrix();

translate(935+960*cos(radians(120)),1003-960*sin(radians(120))); rotate(radians(-30));
text("'120°",0,0);

resetMatrix();

translate(940+960*cos(radians(150)),1018-960*sin(radians(150))); rotate(radians(-60));
text("'150°",0,0);

popMatrix();

V. RESULTS AND DISCUSSION

This study sought to first design of a motion detector to detect approaching objects and raise a light (from an LED) and
a sound alarm (from a sound buzzer). To achieve this, the components that include the Arduino Uno, resistors, LEDs,
buzzer, LCD and ultrasonic sensor were fixed to the breadboard and connected as described in chapter three. Thus, shows
the connections in progress. A jumper wire was connected from the 5 volts port from the Vcc port in the microcontroller
chip to the positive channel of the breadboard. Another cable was grounded to the negative terminal of the breadboard
from the GND port of the chip. A piezo buzzer having two terminals, positive terminal was connected to the pin 13 at
the Arduino while the negative part was interfaced with 330 Ohms resister and connected to the lower channel of the
breadboard. When the power source was connected as in piezo buzzer produced a single tone signal to indicate that power
was flowing through it. The limit set for the Piezo Buzzer was to produce the sound alarm at the distance greater than
Ocm and less than 150cm.
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Fig 3.1 Circuit for arrangement resistors and ultra-sonic sensors

The ultrasonic sensor having four pins, Echo was connected to pin number 11 while Trig being connected to pin
numberl2 in the Arduino Uno. VVcc was connected to the upper channel while the Ground (Gnd) to the lower channel of
the breadboard. Before enclosing the assembly in a casing, the complete connection as shown was connected to a power
supply, to confirm if it’s working as expected. When power was applied as in the piezo buzzer produced continuous
sound alarm. Birds are a unit one in all the foremost perturbing birds in numerous areas. We tend to predict effective
results once experimenting with the pigeons that may provide aerodromes a productive resolution to avoid Bird Strikes.
The pigeons got repelled at a frequency of 37 KHz and a small variation in the frequency between 35-37 KHz causes
variation in the bird. The below figure is the device built by us.

VI. CONCLUSION

The above proposed method will be effective with proper delivery of frequencies to be generated. For real-time purpose
(i.e. device on the aircraft) must radiate these frequencies with enormous power for effective results. The use of ultrasonic
waves; which human ears do not detect, but are perceived by small birds is a novel technology that can effectively repel
such birds from designated places. Ultrasonic waves was successfully generated, with automatically varied frequency
(between 15kHz and 25kHz), amplified and broadcast at high enough sound pressure level from a locally fabricated solar
powered electronic device. The 7.98W device produced an ultrasound of 118dB, on the average will cover a distance of
45.02m while the 23.98Wwith an ultrasound of 123dB will cover a distance of 232.26m when placed on the elevation of
0.78m but when placed on the elevation of 1.86m, their average area respectively. The ultrasonic waves created a hostile
environment for the pest birds and had a repulsive influence on them, though they have a small radius of action but
eventually drove the birds away from the designated locations. Response to the ultrasonic wave stimulus broadcasted
from the environmentally friendly gadget was visibly demonstrated by targeted weaver birds and black birds but not
quelea birds. The waves travelled farther with increasing power of the gadget and for wet days than for dry days. This is
advantageous as rain-fed cereal crops fruit during the rainy season and will need the deployment of the gadget more at
such a period. About 5-6 pieces of the 23.98W device will be needed to cover a hectare sized field.

REFRENCES

1. S. M. Satheesan, 1999, “Zero bird-strike rate - an achievable target, not a pipe dream”, University of Nebraska,
Lincoln, Bird Strike Committee Proceedings.

2. S. Aravind, B. Ganesh, R. Mousia, S. Vignesh, October, 2014, “Optimization of Bird Hazard Reduction in Coimbatore
International Airport”, Krishi Sanskriti Publications, Vol 1, No 5.

3. Zdobyslaw Goraj, Kamila Kustron, April 2018 “Review of Current Research Trends in Bird Strike and Hail Impact
Simulations on Wing Leading Edge”, Article in Aircraft Engineering and Aerospace Technology.

4. https://www.researchgate.net/publication/324189256_Review_of current_research_t rends_in_bird_strike_and_ha
il_impact_simulations_on_wing_leading_edge

5. Isabel C. Metz, Joost Ellerbroek, Thorsten Miihlhausen, Dirk Kiigler, Jacco M. Hoekstra, 13 March 2020“The Bird
Strike Challenge”, MDPI, received: 13 February 2020; Accepted: 9 March 2020;

6. Jaiye Jehoshaphat Dukiya, Vimal Gahlot, and 25 October 2012 “An Evaluation of Bird Strikes on Flight Safety
Operations at International Airports”.

7. Fuliang Le, Jiawei Luo, Gongping Wu, 2009, “An Uninterrupted Bird Repeller on Transmission Line”, Proceedings
of the 2009 IEEE International Conference on Robotics and Biomimetics, China.

8. Yahot Siahaan, Bheta Agus Wardijono and Yulisdin Mukhlis, 2017 “Design of Birds Detector and Repellent Using
Frequency Based Arduino Uno with Android System”.

9. Navinesshani Permal, Thiviya Barathi Raja Segaran, Renuga Verayiah, Farrukh Hafiz Nagi, Agileswari K.

© IARJSET This work is licensed under a Creative Commons Attribution 4.0 International License 159


https://iarjset.com/
http://www.researchgate.net/publication/324189256_Review_of_current_research_t

10.

11.
12.
13.
14,
15.
16.

IARJSET ISSN (0) 2393-8021, ISSN (P) 2394-1588

F@g International Advanced Research Journal in Science, Engineering and Technology
o

)
ISO 3297:2007 Certified 32 Impact Factor 7.105 3¢ Vol. 9, Issue 8, August 2022

DOI: 10.17148/IARJSET.2022.9822

Ramasamy,2019 “Hardware Implementation of Beam Formed Ultrasonic Bird Deterrent System”, IEEE 4th
International Conference on Computer and Communication Systems.

V. Arun pandiyan, J. Murugan Senthamilan, D. Uday Kumar, V. Vinithkumar, March 2019 “Fabrication of Mobile
Ultrasonic Bird Repeller” International Journal of Innovative Research in Advanced Engineering (IJIRAE) Issue 03,
Volume 6.

https://www.boeing.com/commercial/aeromagazine/articles/2011_q3/4
https://lasmentirasdebarajas.blogspot.com/2012_05_ 25 archive.html
https://www.skybrary.aero/index.php/Bird_Strike
https://www.sciencedirect.com/topics/nursing-andhealth-professions/transducer
https://www.boeing.com/commercial/aeromagazine/articles/2011_q3/4
https://indianexpress.com/article/business/aviation/ahmedabad-leads-among- ~ major-airports-in-wildlifestrikes-11-
cases-for-every-10000-flights-6274972.

© IARJSET This work is licensed under a Creative Commons Attribution 4.0 International License 160


https://iarjset.com/
http://www.skybrary.aero/index.php/Bird_Strike
http://www.sciencedirect.com/topics/nursing-andhealth-professions/transducer
https://indianexpress.com/article/business/aviation/a%20hmedabad-leads-among-major-airports-in-wildlifestrikes-11-cases-for-every-10000-flights-6274972
https://indianexpress.com/article/business/aviation/a%20hmedabad-leads-among-major-airports-in-wildlifestrikes-11-cases-for-every-10000-flights-6274972

